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Principle 
The Cellavision DM9600 is an automated digital cell morphology system.  A stained 
peripheral blood smear is automatically scanned and images are made, stored and 
preclassified ready for a clinical lab scientist to edit and verify classification.  These 
images are archived and may be accessed by anyone with the appropriate security and 
remote viewing computer software. 
 
The Cellavision DM9600 is used in place of an optical microscope for many specimens.  
Peripheral blood smears from specimens with results requiring slide review based on 
abnormalities suspected by automated CBC analysis or because a manual differential was 
ordered are analyzed on the Cellavision.  A qualified clinical laboratory scientist views 
all WBC, RBC, and Platelet digital images and edits the classifications if needed.  Results 
are reported using the entries made to the Cellavision screens transferring to the LIS via 
the Remisol middleware software after signing the slide. 
 
Cellavision CM9600 operation and features are outlined in this procedure. Refer to the 
complete Cellavision DM 9600 User’s Manual, available electronically on the instrument 
help files, and as a book at the bench, for more details.  The information is used in 
conjunction with the following Hematology procedures to complete the differential 
review process. . 
 
 LH 780 Procedure    Technical Procedure #1510 
 LH 780 (Interpretation & Rechecks)  Technical Procedure #1515 
 LH 780 Automated Differential Review Technical Procedure #1516 
 Reporting of Peripheral Blood Morphology Technical Procedure #1140 
 Hemastainer Maintenance and Operation Technical Procedure #1142 
 Normal Peripheral Blood Smear  Technical Procedure #1145 
 Processing Procedure    Technical Procedure #1150 
 Beckman Remisol Middleware  Technical Procedure #1530 
 
Specimen 

A. Collect blood and prepare smears using the Coulter LH instrument or manually, 
according to Processing Procedure #1150. 

1. Use clean, dry microscope glass slides with clipped or rounded corners to 
avoid glass breakage and shards. 

2. Requirements for a good smear: 

a. There is no pooling of specimen at the point of application. 

b. Both sides of the film are less than 5mm from the edges of the slide. 
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c. The feathered edge is relatively straight and not pointed. 

d. There must not be any streaks, troughs, ridges, holes or bubbles.  

e. The blood film must be at least 30 mm in length and terminate 5-15 mm from the 
end.  

f. A thick smear will interfere with the DM’s ability to find a monolayer and with the 
Artificial Neural Network which may result in a large number of misclassified 
WBC’s.   

3. See illustrations on pages 148-149 in the Cellavision User’s Manual for 
examples of acceptable and unacceptable smears. 

Equipment and Supplies 
A. Cellavision DM 9600 

B. Orange PB Cellavision Slide Magazines (box of 5): Item No. XU-10023 
(Sysmex) 

C. Stage Oil Packs: Item No. XU-10135-01 (Sysmex) Sufficient for about 3000 
drops 

D. Cellavision QC barcode labels: Item No. XU-10023 1000 labels/roll 

E. Snowcoat beveled slides 

F. Cotton-tipped applicators 

G. Lens paper 

H. Isopropyl Alcohol 

 
Daily Quality Control and Instrument Checks  

A. Quality Control – Daily Cell Location Test 

1. Perform QC Cell Location – Peripheral Blood Once per day at the beginning 
of dayshift. 

2. Select a slide with a WBC count greater than 7x103/µL to reduce the 
processing time.  

3. Label the slide with a QC label. 
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4. Load the slide into a magazine and place on DM9600 for processing. The 
slide is scanned using the same method used to collect images for patient 
samples.   

5. Once processing is complete, open the Tools menu and select Cell Location.  
Select the new slide at the top of the list.  (Cell location results automatically 
delete after 5 days.) 

6. Review each image for any missed nucleated cells.  Double-click an area for 
magnification if necessary.  

7. Green boxes mark nucleated cells.  The cell does NOT have to be completely 
inside the box. As long as there is a box associated with a cell and displays, 
this indicates that the system has found the cell. 

8. Blue boxes mark artifacts or other objects. The number of these objects must 
not exceed 30%. 

9. Missed cells are those not marked with ANY box. 

a. Double click on the suspected cell to enlarge and see if the object is really a cell 
that was missed.  A missed cell will appear as a cell in the enlarged image.  
Artifact will display no cell in the enlarged image. 

10. Black boxes mark cells not needed in the 200 cell process for cell location. 
They may not display in order so black boxes may appear in the middle of the 
cell location display. 

11. Review all images by clicking the right arrow button.  For each image, enter 
the number of missed cells in the input field. 

12. When all images have been examined, the result will appear as a ‘%’ on the 
left side of the screen.  

13. Record results on the maintenance log. Results may also be printed by 
clicking Print Result. 

14. Results must be >97.0%.  

a. If result is less than the acceptable percentage, dry clean the objectives with lens 
paper and repeat QC. 

b. If acceptable result cannot be obtained, discontinue use of DM9600 and notify 
Supervisor or Specialist.     
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Procedure 
A. Process Slides 

1. Open the input/output door and put the magazines on the input conveyer on 
the top shelf with the barcodes facing up and towards the back of the 
instrument. 

2. Close the input/output door. 

3. The process starts automatically. Slide magazines will be pushed over to the 
loader and presented to the gripper area for analysis. 

4. Remove completed magazines from the lower conveyer in the input/output 
door.  If the conveyer is too full, new magazines cannot be processed and a 
message will pop up on the screen alerting the operator that the output queue 
is full. 

B. Review Processed Slides. 

1. Select View/Database View 

2. Select the Order ID (barcode number) from either the Worklist or the 
Database by double-clicking on it. 

3. Review WBCs 

a. If performing a manual differential all cells must be classified completely. 

a) WBCs are presented, by class, in galleries. 

b) The WBC gallery that was viewed last is displayed. 

c) Switch to WBC Full Screen (icon with the green mark), One Gallery, 
Two Galleries, or Three Galleries, by clicking on the appropriate icon at 
the top of the screen  

d) ALL unidentified cells must be identified in order to sign a slide. 

e) ALL cell classes, including smudge cells and artifacts, must be 
“touched” by clicking on at least one cell in the class, even if no changes 
are made, in order to complete (sign) a slide.  

f) The operator MUST scroll down to the bottom of the page to visualize 
all cells as well in order to sign a slide. 
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b. Reclassify WBCs by: 

g) Dragging and dropping them from one gallery to another. 

h) Dragging and dropping them from one gallery to WBC or non-WBC 
panel. 

i) Right-clicking on a cell to reclassify it using the displayed cell list. 

j) More than one cell at a time may be selected and reclassified using the 
following keyboard functions: 

k) Holding down the shift key, click on the first and last cells in a group to 
select all of them, then drag and drop or right click to reclassify the cells. 

l) Holding down the control key, click on each cell to be reclassified, then 
drag and drop or right-click to reclassify the cells. 

c. If a scan diff is performed and the visual inspection of the Cellavision agrees with 
the Coulter Counter results, Click on the Cell Counter Confirm button (the 
green check mark) to suppress the manual differential from the Cellavision and 
send a message to the Remisol to accept the automated differential. 

d. To add additional comments about left shift, toxic granulation etc., move to any 
gallery screen (cannot be performed in the Overview screen).  

e. Add WBC Comments by clicking on the WBC Comments button on the lower left 
side of the summary.  

f. Left shift comments, toxic granulation as well as WBC morphology comments are 
added here.  Double click on a comment or click and append to bring the 
comment up into the upper comment box to add a comment to a sample. 

4. Review RBCs 

a. Click on the RBC tab to view the RBC field. 

b. Analyze RBCs in this view using the zoom mode 6 times (magnifying glass icon) 
to enlarge the cells and approximate one 100X field, and the scroll mode (hand 
icon) to move from field to field. 

c. The micrometer tool may be used to estimate the diameter of the cells, in microns, 
by clicking it and dragging it into the RBC field.  The micrometer is resized 
along with the RBCs when zooming.  Note:  Normal RBCs are 6-8 microns in 
diameter. 
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d. Characterize the RBC morphology as “Report as Zero-Normal”  or “Use 
characterization” by choosing one of the toggle switches at the upper left side of 
the screen.  Choose the 1, 2, or 3 toggle switch for each morphology added for Sl, 
Md, or Mk.  Occasional or rare options are available for a few of the more 
significant parameters under RBC Comments.  They are added as described 
above in WBC Comments. 

e. The RBC morphology is arranged into the categories of Color, Size, Shape, 
Inclusions, and User Group.  Those items that are specific to UCD are located 
under user group. 

f. There are several WBC parameters noted on the RBC morphology screen as they 
are graded SL, MD, MK as well.  These include Dohle Bodies and 
Hypersegmentation. 

g. Also available on the RBC morphology screen is a trigger to send WBC and/or 
PLT values from the Remisol to the LIS automatically from the Cellavision.  

m) Press 1 on WBC/PLT to send both WBC and PLT count over to LIS. 

n) Press 2 on WBC/PLT to send the WBC only over to the LIS. 

o) Press 3 on WBC/PLT to send the PLT only over to the LIS. 

5. Review Platelets 

a. Click on the Platelet tab to view the platelet overview image. 

b. One of the 9 sub-images of the complete PLT overview image (same image as for 
RBC) is displayed.  To see all 9 sub-images, click on each entry field to tab to the 
next sub-image. 

c. Click on the Help Lines in the toolbar to display lines drawn over the image to 
facilitate platelet counting. A tic tac toe grid is superimposed on the sub-image 
dividing it into 9 squares. 

d. Counting platelets in the overview image. 

e. There are two ways (modes) of performing platelet estimates.  The platelet 
estimate is based on the number of PLTs, which must be counted manually.  You 
can choose to count the number of PLTs in each grid square (entire displayed 
square, with or without help lines) or to specify and approximate number of PLTs 
per grid square. 

i. Specifying an approximate PLT count per grid square. 

a) Select the Approximate PLTS per grid square radio button. 
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b) Use the entry fields to view different grid squares. 

c) Estimate the average PLT count per grid square and type this value in the 
field. 

d) Counting PLTs per grid square 

ii. Select the Count PLTs per grid square radio button. 

a) Select the entry fields (divided by help lines) and count platelets in the 
image window and type the number in the entry field.  You can use tab 
and shift+tab to move between entry fields. 

f. PLT Result: deriving number 

i. Click Calculate PLT Result in the PLT Count Panel. 

ii. The PLT concentration is displayed, along with a qualitative estimate. 

iii. The platelet estimate here is a quantitative number and is used only for 
comparison purposes. 

iv. The platelet estimate may be significantly affected by atypical RBC and 
PLT distributions as well as platelet clumping.  

g. Reporting platelet estimate 

i. Select Exclude PLT Analysis. 

ii. Plt estimates and Plt morphology comments are added in the PLT 
Comments section of the Platelet screen in the same way as WBC and 
RBC comments. 

iii. When clumping is suspected by abnormal platelet or WBC 
histogram/flags, a low or decreasing (by delta check) platelet count, the 
presence of even one clump may be significant. Platelet clumps can be 
viewed not only on the PLT estimation tab but also in the background on 
the WBC images or in the thrombocyte aggregate category on the WBC 
tab, but also on the RBC morphology image as well. Utilizing all three 
areas maximizes the chances of seeing platelet clumping. 

iv. It is not possible to view the feathered edge on the Cellavision.  When 
there is a strong suspicion about clumping, look at the feathered edge on 
a regular microscope.  
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6. Partial review of slides on Cellavision. 

a. There are no rules that say all three pieces (WBC, RBC, PLT) of the smear review 
must be performed by the same method (Cellavision vs manual). 

b. If some of the WBC’s are odd looking, review WBC on the scope and RBC and 
PLT on the Cellavision. 

c. If the RBC morphology area is bad while the WBC images are good (they are 
performed separately), do the RBC morphology on the scope and the WBC on 
the Cellavision. 

7. Sign Slides (confirms that the differential is complete) 

a. Click Sign.  The Sign Slide dialog appears. 

b. Enter User name and Password if not defaulted to correct user and password.  

c. Click OK to sign both the slide and the order and transmit the data to the Remisol 
and from there to the LIS. 

d. When the slide is signed, it may printed. 

e. If multiple slides are being used for a differential, each slide must be signed 
individually before they are merged; then sign the order after merging. 

f. Note:  No slide data can be changed after signing.  Data can be added and 
transmitted to the Remisol after signing by adding the desired comments in the 
appropriate areas then going to report view and choosing Send to LIS. A slide 
and its results can only be deleted by someone with Administrator access 
(supervisor, specialist). 

g. NOTE: The option to “Sign order when signing slide” is not available if the slide 
is part of a multi-slide order; all slides must be signed before the order can be 
signed.  

h. To merge multiple slides from an order, click the “Slide Merge” tab in “Report 
View”. Results from all slides in the order display. Slide Merge should not be 
used if one or more slides have a “Confirm Cell Counter result”. If these slides 
are merged the number of cell percentages reported is incorrect and Only signed 
slides can be included. 

i. Click in the checkbox next to a slide ID to include it in the results of the order. If a 
slide is excluded, a dialog displays to enter explanation of exclusion.  
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Maintenance 
A. Note:  Shut down the system before performing maintenance procedures.  Start up 

to resume operation. 

B. Shut down system once weekly before performing maintenance. 

1. Select Exit in the File menu on the computer. 

2. Press ctrl/alt/delete.  

3. Select Shutdown. 

4. Switch off the slide scanning unit (SSU) by toggling the power switch located 
on the front right side of the SSU.  

C. Start Up Operator Checks 

1. Verify the following before powering on: 

a. The input and output area is empty. 

b. Maintenance procedures are complete (See Maintenance Section). 

2. Start Up the System 

a. Switch on the slide scanning unit. 

b. Wait until the light amber Status Lamp on the slide scanning unit is 
CONTINUOUSLY lit. 

c. Switch on the system computer by pressing the power button. 

d. In the Log On dialog box, type username, password, and select the appropriate 
database to process routine patient smears.   

e. Click OK. 

D. Daily Maintenance 

1. The only Daily “maintenance” is performing the Cell Location as described 
above and clearing the magazine log. 

a. Clear System Control Log 

b.  From the System Control View screen, click “Clear Log”. 
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E. Weekly Maintenance: Refer to Cellavision  DM9600 User’s Manual for details 
and images. 

1. Shutdown the system as described above. 

2. Switch off the Slide Scanning Unit using the power button located on the front 
of the unit. 

3. Cleaning of Objectives and LED Table 

a. After assuring that the system is in Shutdown and powered off: 

b. Open the hood. 

c. Pull out the stop pin and open the magazine feeder. 

d. Gently wipe the LED table with a DRY lint free soft cloth.  Do not use any solvent 
when cleaning the LED table. 

e. Use lens paper and gently wipe the lens of each objective.  Use a fresh piece of 
paper for each lens in order not to get oil on the low power (10x) dry objective.   

f. When needed, but perform judiciously, place a drop of isopropyl alcohol on a piece 
of lens paper. Place the lens paper under the objective.  Hold the paper against 
the objective while dragging the lens paper away from the objective. 

g. Cleaning with alcohol increases the risk of air bubbles on the objective.  It is 
recommended to run two (2) slides immediately after performing weekly 
maintenance.  Delete the slides from the list immediately to avoid result mix-up. 

4. Clean Magazine Feeder 

a.  Open the input hatch. 

b. Wipe the infeed conveyor and the outfeed shelf with a moist cloth. 

5. Clean Bottom Tray 

a. Open the hood. 

b. Pull out the stop pin and open the magazine feeder.  

c. Pull out the bottom tray and wipe clean any immersion oil. 
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6. Clean Hood 

a. Wipe the hood with a moist cloth when necessary using water only. 

7. Delete Unsigned Orders: At least one time per week, delete unsigned or failed 
orders. 

a. From the Processed Order List in Database View, choose Search Criteria – View 
All, choose Search. 

b. Select an order from the Processed Order list in the Database View. Multiple slides 
can be selected using Shift or Control. 

c. Click the “Delete” button below the list. 

d. If multiple slides are present in an order, a single slide can be deleted by selecting 
the order from the Processed Order list. The slides within the order display in the 
“Slides” area on the right side of the Database View. 

e. Highlight the slide to be deleted and click the “Delete” button below the box. 

 
F. As Needed Maintenance 

1. Change Immersion Oil Pack 

a. Open the Hood. 

b. Place clip on hose. 

c. Push down on the oil hose connection and pull out the hose. 

d. Change the oil pack and connect the hose. 

e. Remove the clip from the hose. 

f. Go to Maintenance / Oil. 

g. If the old oil pack ran dry and all hoses are empty, click Prime Oil. Repeat as 
necessary until Successful is shown. 

h. Click Reset Oil Drop Counter. 

2. Database Archive 

a. Archiving must be done by one of the specialists since the Cellavision database 
resides on the network server. 
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b. Log into Cellavision computer with personal Citrix password. 

c. Open Cellavision software. 

d. Go to Tools/Archive 

e. Follow the Archive Wizard instructions. 

f. Archive settings: 

i. Archive settings are established in Tools/Settings/Archive and may be 
changed by a Cellavision administrator only, if needed. 

ii. Current archive settings are: 

a) Keep locally at least 5 days. 

b) Warn when candidates reach 200 signed orders. 

iii. Archive to: hsimages01\Cellavision\Archive. 

iv. Complete explanations about archiving are in the Cellavision DM 9600 
User’s Manual pages 76, 103 and 115.   

Troubleshooting 
A. Troubleshooting Charts -Cellavision DM 96 User’s manual pages 116-127. 

B. The charts include many helpful hints on Startup Problems, Error Messages, 
General Processing Problems, Cell Location Issues, Barcode and Staining 
Problems. 

C. Gripper Service position is used to remove broken or loose slides from the 
system. 

1. Go to Maintenance/Gripper Service. 

2. Click OK. 

3. Wait until The gripper is in service position dialog appears. 

4. Open the Hood. 

5. Pull out the stop pin and open the magazine feeder. 

6. Remove the slide. 
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7. Close the hood and the magazine feeder. 

8. Restart the SSU and the program. 
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	A. Collect blood and prepare smears using the Coulter LH instrument or manually, according to Processing Procedure #1150.
	1. Use clean, dry microscope glass slides with clipped or rounded corners to avoid glass breakage and shards.
	2. Requirements for a good smear:
	a. There is no pooling of specimen at the point of application.
	b. Both sides of the film are less than 5mm from the edges of the slide.
	c. The feathered edge is relatively straight and not pointed.
	d. There must not be any streaks, troughs, ridges, holes or bubbles.
	e. The blood film must be at least 30 mm in length and terminate 5-15 mm from the end.
	f. A thick smear will interfere with the DM’s ability to find a monolayer and with the Artificial Neural Network which may result in a large number of misclassified WBC’s.

	3. See illustrations on pages 148-149 in the Cellavision User’s Manual for examples of acceptable and unacceptable smears.

	A. Cellavision DM 9600
	B. Orange PB Cellavision Slide Magazines (box of 5): Item No. XU-10023 (Sysmex)
	C. Stage Oil Packs: Item No. XU-10135-01 (Sysmex) Sufficient for about 3000 drops
	D. Cellavision QC barcode labels: Item No. XU-10023 1000 labels/roll
	E. Snowcoat beveled slides
	F. Cotton-tipped applicators
	G. Lens paper
	H. Isopropyl Alcohol
	A. Quality Control – Daily Cell Location Test
	1. Perform QC Cell Location – Peripheral Blood Once per day at the beginning of dayshift.
	2. Select a slide with a WBC count greater than 7x103/µL to reduce the processing time.
	3. Label the slide with a QC label.
	4. Load the slide into a magazine and place on DM9600 for processing. The slide is scanned using the same method used to collect images for patient samples.
	5. Once processing is complete, open the Tools menu and select Cell Location.  Select the new slide at the top of the list.  (Cell location results automatically delete after 5 days.)
	6. Review each image for any missed nucleated cells.  Double-click an area for magnification if necessary.
	7. Green boxes mark nucleated cells.  The cell does NOT have to be completely inside the box. As long as there is a box associated with a cell and displays, this indicates that the system has found the cell.
	8. Blue boxes mark artifacts or other objects. The number of these objects must not exceed 30%.
	9. Missed cells are those not marked with ANY box.
	a. Double click on the suspected cell to enlarge and see if the object is really a cell that was missed.  A missed cell will appear as a cell in the enlarged image.  Artifact will display no cell in the enlarged image.

	10. Black boxes mark cells not needed in the 200 cell process for cell location. They may not display in order so black boxes may appear in the middle of the cell location display.
	11. Review all images by clicking the right arrow button.  For each image, enter the number of missed cells in the input field.
	12. When all images have been examined, the result will appear as a ‘%’ on the left side of the screen.
	13. Record results on the maintenance log. Results may also be printed by clicking Print Result.
	14. Results must be >97.0%.
	a. If result is less than the acceptable percentage, dry clean the objectives with lens paper and repeat QC.
	b. If acceptable result cannot be obtained, discontinue use of DM9600 and notify Supervisor or Specialist.


	A. Process Slides
	1. Open the input/output door and put the magazines on the input conveyer on the top shelf with the barcodes facing up and towards the back of the instrument.
	2. Close the input/output door.
	3. The process starts automatically. Slide magazines will be pushed over to the loader and presented to the gripper area for analysis.
	4. Remove completed magazines from the lower conveyer in the input/output door.  If the conveyer is too full, new magazines cannot be processed and a message will pop up on the screen alerting the operator that the output queue is full.

	B. Review Processed Slides.
	1. Select View/Database View
	2. Select the Order ID (barcode number) from either the Worklist or the Database by double-clicking on it.
	3. Review WBCs
	a. If performing a manual differential all cells must be classified completely.
	a) WBCs are presented, by class, in galleries.
	b) The WBC gallery that was viewed last is displayed.
	c) Switch to WBC Full Screen (icon with the green mark), One Gallery, Two Galleries, or Three Galleries, by clicking on the appropriate icon at the top of the screen
	d) ALL unidentified cells must be identified in order to sign a slide.
	e) ALL cell classes, including smudge cells and artifacts, must be “touched” by clicking on at least one cell in the class, even if no changes are made, in order to complete (sign) a slide.
	f) The operator MUST scroll down to the bottom of the page to visualize all cells as well in order to sign a slide.

	b. Reclassify WBCs by:
	g) Dragging and dropping them from one gallery to another.
	h) Dragging and dropping them from one gallery to WBC or non-WBC panel.
	i) Right-clicking on a cell to reclassify it using the displayed cell list.
	j) More than one cell at a time may be selected and reclassified using the following keyboard functions:
	k) Holding down the shift key, click on the first and last cells in a group to select all of them, then drag and drop or right click to reclassify the cells.
	l) Holding down the control key, click on each cell to be reclassified, then drag and drop or right-click to reclassify the cells.

	c. If a scan diff is performed and the visual inspection of the Cellavision agrees with the Coulter Counter results, Click on the Cell Counter Confirm button (the green check mark) to suppress the manual differential from the Cellavision and send a me...
	d. To add additional comments about left shift, toxic granulation etc., move to any gallery screen (cannot be performed in the Overview screen).
	e. Add WBC Comments by clicking on the WBC Comments button on the lower left side of the summary.
	f. Left shift comments, toxic granulation as well as WBC morphology comments are added here.  Double click on a comment or click and append to bring the comment up into the upper comment box to add a comment to a sample.

	4. Review RBCs
	a. Click on the RBC tab to view the RBC field.
	b. Analyze RBCs in this view using the zoom mode 6 times (magnifying glass icon) to enlarge the cells and approximate one 100X field, and the scroll mode (hand icon) to move from field to field.
	c. The micrometer tool may be used to estimate the diameter of the cells, in microns, by clicking it and dragging it into the RBC field.  The micrometer is resized along with the RBCs when zooming.  Note:  Normal RBCs are 6-8 microns in diameter.
	d. Characterize the RBC morphology as “Report as Zero-Normal”  or “Use characterization” by choosing one of the toggle switches at the upper left side of the screen.  Choose the 1, 2, or 3 toggle switch for each morphology added for Sl, Md, or Mk.  Oc...
	e. The RBC morphology is arranged into the categories of Color, Size, Shape, Inclusions, and User Group.  Those items that are specific to UCD are located under user group.
	f. There are several WBC parameters noted on the RBC morphology screen as they are graded SL, MD, MK as well.  These include Dohle Bodies and Hypersegmentation.
	g. Also available on the RBC morphology screen is a trigger to send WBC and/or PLT values from the Remisol to the LIS automatically from the Cellavision.
	m) Press 1 on WBC/PLT to send both WBC and PLT count over to LIS.
	n) Press 2 on WBC/PLT to send the WBC only over to the LIS.
	o) Press 3 on WBC/PLT to send the PLT only over to the LIS.


	5. Review Platelets
	a. Click on the Platelet tab to view the platelet overview image.
	b. One of the 9 sub-images of the complete PLT overview image (same image as for RBC) is displayed.  To see all 9 sub-images, click on each entry field to tab to the next sub-image.
	c. Click on the Help Lines in the toolbar to display lines drawn over the image to facilitate platelet counting. A tic tac toe grid is superimposed on the sub-image dividing it into 9 squares.
	d. Counting platelets in the overview image.
	e. There are two ways (modes) of performing platelet estimates.  The platelet estimate is based on the number of PLTs, which must be counted manually.  You can choose to count the number of PLTs in each grid square (entire displayed square, with or wi...
	i. Specifying an approximate PLT count per grid square.
	a) Select the Approximate PLTS per grid square radio button.
	b) Use the entry fields to view different grid squares.
	c) Estimate the average PLT count per grid square and type this value in the field.
	d) Counting PLTs per grid square

	ii. Select the Count PLTs per grid square radio button.
	a) Select the entry fields (divided by help lines) and count platelets in the image window and type the number in the entry field.  You can use tab and shift+tab to move between entry fields.


	f. PLT Result: deriving number
	i. Click Calculate PLT Result in the PLT Count Panel.
	ii. The PLT concentration is displayed, along with a qualitative estimate.
	iii. The platelet estimate here is a quantitative number and is used only for comparison purposes.
	iv. The platelet estimate may be significantly affected by atypical RBC and PLT distributions as well as platelet clumping.

	g. Reporting platelet estimate
	i. Select Exclude PLT Analysis.
	ii. Plt estimates and Plt morphology comments are added in the PLT Comments section of the Platelet screen in the same way as WBC and RBC comments.
	iii. When clumping is suspected by abnormal platelet or WBC histogram/flags, a low or decreasing (by delta check) platelet count, the presence of even one clump may be significant. Platelet clumps can be viewed not only on the PLT estimation tab but a...
	iv. It is not possible to view the feathered edge on the Cellavision.  When there is a strong suspicion about clumping, look at the feathered edge on a regular microscope.


	6. Partial review of slides on Cellavision.
	a. There are no rules that say all three pieces (WBC, RBC, PLT) of the smear review must be performed by the same method (Cellavision vs manual).
	b. If some of the WBC’s are odd looking, review WBC on the scope and RBC and PLT on the Cellavision.
	c. If the RBC morphology area is bad while the WBC images are good (they are performed separately), do the RBC morphology on the scope and the WBC on the Cellavision.

	7. Sign Slides (confirms that the differential is complete)
	a. Click Sign.  The Sign Slide dialog appears.
	b. Enter User name and Password if not defaulted to correct user and password.
	c. Click OK to sign both the slide and the order and transmit the data to the Remisol and from there to the LIS.
	d. When the slide is signed, it may printed.
	e. If multiple slides are being used for a differential, each slide must be signed individually before they are merged; then sign the order after merging.
	f. Note:  No slide data can be changed after signing.  Data can be added and transmitted to the Remisol after signing by adding the desired comments in the appropriate areas then going to report view and choosing Send to LIS. A slide and its results c...
	g. NOTE: The option to “Sign order when signing slide” is not available if the slide is part of a multi-slide order; all slides must be signed before the order can be signed.
	h. To merge multiple slides from an order, click the “Slide Merge” tab in “Report View”. Results from all slides in the order display. Slide Merge should not be used if one or more slides have a “Confirm Cell Counter result”. If these slides are merge...
	i. Click in the checkbox next to a slide ID to include it in the results of the order. If a slide is excluded, a dialog displays to enter explanation of exclusion.


	A. Note:  Shut down the system before performing maintenance procedures.  Start up to resume operation.
	B. Shut down system once weekly before performing maintenance.
	1. Select Exit in the File menu on the computer.
	2. Press ctrl/alt/delete.
	3. Select Shutdown.
	4. Switch off the slide scanning unit (SSU) by toggling the power switch located on the front right side of the SSU.

	C. Start Up Operator Checks
	1. Verify the following before powering on:
	a. The input and output area is empty.
	b. Maintenance procedures are complete (See Maintenance Section).

	2. Start Up the System
	a. Switch on the slide scanning unit.
	b. Wait until the light amber Status Lamp on the slide scanning unit is CONTINUOUSLY lit.
	c. Switch on the system computer by pressing the power button.
	d. In the Log On dialog box, type username, password, and select the appropriate database to process routine patient smears.
	e. Click OK.


	D. Daily Maintenance
	1. The only Daily “maintenance” is performing the Cell Location as described above and clearing the magazine log.
	a. Clear System Control Log
	b.  From the System Control View screen, click “Clear Log”.


	E. Weekly Maintenance: Refer to Cellavision  DM9600 User’s Manual for details and images.
	1. Shutdown the system as described above.
	2. Switch off the Slide Scanning Unit using the power button located on the front of the unit.
	3. Cleaning of Objectives and LED Table
	a. After assuring that the system is in Shutdown and powered off:
	b. Open the hood.
	c. Pull out the stop pin and open the magazine feeder.
	d. Gently wipe the LED table with a DRY lint free soft cloth.  Do not use any solvent when cleaning the LED table.
	e. Use lens paper and gently wipe the lens of each objective.  Use a fresh piece of paper for each lens in order not to get oil on the low power (10x) dry objective.
	f. When needed, but perform judiciously, place a drop of isopropyl alcohol on a piece of lens paper. Place the lens paper under the objective.  Hold the paper against the objective while dragging the lens paper away from the objective.
	g. Cleaning with alcohol increases the risk of air bubbles on the objective.  It is recommended to run two (2) slides immediately after performing weekly maintenance.  Delete the slides from the list immediately to avoid result mix-up.

	4. Clean Magazine Feeder
	a.  Open the input hatch.
	b. Wipe the infeed conveyor and the outfeed shelf with a moist cloth.

	5. Clean Bottom Tray
	a. Open the hood.
	b. Pull out the stop pin and open the magazine feeder.
	c. Pull out the bottom tray and wipe clean any immersion oil.

	6. Clean Hood
	a. Wipe the hood with a moist cloth when necessary using water only.

	7. Delete Unsigned Orders: At least one time per week, delete unsigned or failed orders.
	a. From the Processed Order List in Database View, choose Search Criteria – View All, choose Search.
	b. Select an order from the Processed Order list in the Database View. Multiple slides can be selected using Shift or Control.
	c. Click the “Delete” button below the list.
	d. If multiple slides are present in an order, a single slide can be deleted by selecting the order from the Processed Order list. The slides within the order display in the “Slides” area on the right side of the Database View.
	e. Highlight the slide to be deleted and click the “Delete” button below the box.


	F. As Needed Maintenance
	1. Change Immersion Oil Pack
	a. Open the Hood.
	b. Place clip on hose.
	c. Push down on the oil hose connection and pull out the hose.
	d. Change the oil pack and connect the hose.
	e. Remove the clip from the hose.
	f. Go to Maintenance / Oil.
	g. If the old oil pack ran dry and all hoses are empty, click Prime Oil. Repeat as necessary until Successful is shown.
	h. Click Reset Oil Drop Counter.

	2. Database Archive
	a. Archiving must be done by one of the specialists since the Cellavision database resides on the network server.
	b. Log into Cellavision computer with personal Citrix password.
	c. Open Cellavision software.
	d. Go to Tools/Archive
	e. Follow the Archive Wizard instructions.
	f. Archive settings:
	i. Archive settings are established in Tools/Settings/Archive and may be changed by a Cellavision administrator only, if needed.
	ii. Current archive settings are:
	a) Keep locally at least 5 days.
	b) Warn when candidates reach 200 signed orders.

	iii. Archive to: hsimages01\Cellavision\Archive.
	iv. Complete explanations about archiving are in the Cellavision DM 9600 User’s Manual pages 76, 103 and 115.



	A. Troubleshooting Charts -Cellavision DM 96 User’s manual pages 116-127.
	B. The charts include many helpful hints on Startup Problems, Error Messages, General Processing Problems, Cell Location Issues, Barcode and Staining Problems.
	C. Gripper Service position is used to remove broken or loose slides from the system.
	1. Go to Maintenance/Gripper Service.
	2. Click OK.
	3. Wait until The gripper is in service position dialog appears.
	4. Open the Hood.
	5. Pull out the stop pin and open the magazine feeder.
	6. Remove the slide.
	7. Close the hood and the magazine feeder.
	8. Restart the SSU and the program.
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